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Abstract

In many countries like India, there are more rural areas as compared to cities. In rural
areas, due to the lack of medical facilities, people are not much concerned about their health.
Even for a routine check-up, they need to travel a long distance. Pregnancy demands a
routine check-up and women in rural areas don 't do their regular check-ups at an early stage
of pregnancy. A routine check-up can help in reducing the fetal mortality rate and to identify
and reduce risks (if any) for the mother and the baby. In this paper, the system allows the
interaction of doctors with pregnant women through the mobile application. Some crucial
parameters of pregnant women like heartbeat rate, blood pressure, temperature, and fetus
movement (kicking) are measured and stored in the cloud. The android application can
access this information. Whenever there is any fluctuation that happens from the normal
value, an alert message is sent to the doctor’s mobile application. Hence, doctors can
monitor the health of pregnant women. The purpose of this system is to record the parameters
of the pregnant woman and deliver the recorded results to the doctor so that the routine
health status of the pregnant woman can be monitored without going to the hospital.

Keywords: MAX30205 sensor ESP8266 Wi-Fi Module, Android application, Firebase,
Internet of Thing

1. Introduction

Every year, pregnant women in a million face medical problems like diabetes, hypertension.
A significant medical illness is faced by more than 40, 000 pregnant women in the US in a
year [1][2].

The foundation for the progress and existence of any nation is human. Human life safety is
the most perplexed yet paramount area which is always a matter of discussion. Pregnant
woman safety is, therefore, one of the things we have worked for keeping in mind the current
situation. The death rate of pregnant women is quite high, especially in rural areas.

According to the facts given by WHO, “Every day in 2017, approximately 810 women
died from preventable causes related to pregnancy and childbirth” One out of twelve women
in western Europe enter into the pregnancy period with a chronic medical condition that
requires pharmaceutical treatment [3].
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It is well known by clinicians that the evidence base to determine how to treat the medical
conditions of pregnant women is distressingly poor [4]. In rural areas, pregnant women are
not much concerned about their health and don’t go for routine check-ups. They need to travel
a lot due to the lack of proper hospitals and clinics in villages. A routine check-up is very
important during pregnancy to identify the health status of the baby and the mother. Fetal
movement is a way used to access fetal well-being [5]. Pregnant women may be vulnerable to
changes in ambient temperature and warming climates [6]. Hypertensive disorders represent
major causes of pregnancy-related maternal mortality worldwide [7]. The various health
monitoring system and many movement recognition systems have been developed for human
motion capture in virtual reality and biomedical applications including mechanical trackers
and health monitoring using smart sensors [8].

In our proposed system, crucial parameters like heartbeat rate, temperature, blood pressure,
and kicking are measured with the help of sensors. The information from the sensors is stored
in the cloud [9]. The android application can access this information. This application will be
present on the mobile of doctors, pregnant women, and her husband. In case of fluctuations in
the parameters of women from the normal, an alert message will be sent to the doctor’s
mobile application and the husband’s mobile application using WIFI. Also, the real-time
health parameters result will be displayed in the application. The involvement of doctors will
make this system more reliable for health monitoring. The concern of the proposed work is to
develop a device that can act as a helping hand and take care of the health of the women,
especially for rural areas that can’t go for a regular check-up.

2. Review of related systems

In [10], the proposed system records some vital parameters like a heartbeat, temperature,
and Kicking. It uses a mobile application for displaying all the results and showing the status
of pregnant women. It uses LM35 for temperature measurement, heartbeat sensor for The
Fetal heart rate. The android application shows the status and acts as a helping guide. The
drawback of this system is it can only record the parameters but cannot be a perfect helper for
health monitoring. No medical expert is present to monitor the results so completely relying
on the application could be a factor of risk. No doctor is involved in keeping the records of
the health status of pregnant women. In our paper, doctor advice and guidance are involved.

In [11], this paper deals with the implementation and designing of ECG software
applications. Its main aim was to produce a prototype model of this application. It used
Bluetooth ECG monitoring devices to fulfill the purpose. It also describes the architecture.
Developing an environment and other tools used are also described. Android SDK, Eclipse is
used in the development process. The major result was to establish communication between
sense devices using Bluetooth. The major drawback of this paper was it takes under
consideration only ECG for monitoring and doesn’t include other parameters like temperature,
heartbeat. In our proposed system we have considered all the vital parameters.

In this paper [12], the design and development of a remote patient monitoring system for
pregnant ladies was the main aim of his paper. This system allows interaction between
doctors and pregnant women. hence, proper monitoring of the health status can be done. This
system measures heartbeat rate and temperature. It uses GSM for giving alerts and updates to
the doctor. The limitation is that it doesn’t take into consideration other important parameters
like blood pressure and kicking which is very important during pregnancy. In our paper, we
have considered kicking counts and blood pressure. Also, we have used Wi-Fi technology for
the transmission of data using Node Mcu esp8266.
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In [13], the paper focuses on certain points. It is based on many facts, one such fact is that
strokes and heart attacks are one of the biggest reasons because which elder people are often
hospitalized. The probability of their survival increases a great deal if they are treated within
an hour. The android healthcare device is used by many. With its help, one can detect the fall
of the carrier with the help of an accelerometer using any android Smartphone. Then this
android smartphone is connected to a monitoring system with the help of the TCP/IP via Wi-
Fi. With this system, the elder and chronically ill patients can lead independent lives. They
can live a safe and independent life in the safety of their homes. All this is because their
movements are monitored. The only limitation of this system is that it solely considers the
elder people as there is a higher probability of sudden (emergency) situations such as stroke
and cardiac arrest in their cases. Herein this paper, we have considered various parameters
and not solely considering anyone.

3. Proposed system description

In the proposed system, a product idea of a device named ‘Prega care’ is presented. The
care of a woman while pregnant is always a topic of concern. It’s obvious to note that if
compared to the general people, effective treatments and precautions should be provided to
pregnant women [14]. After the evaluation and analysis of what are the impacts of prenatal,
neonatal, and obstetric care on the health of infants and the low birth weight, there is evidence
showing and indicating there is a need for extra care for pregnant women [15]. If from the
early stage, precautions and health monitoring will start, it will be beneficial for the lives of
the mother and the baby.

Our device aims at performing health monitoring functions by providing a way of
interaction between doctor and woman. Mainly, we have worked on four parameters-Fetus
movements, temperature, blood pressure, and heart rate monitoring. Also, a button will be
provided in the device which when pressed sent a message alert or alarm indication on the
phone of the neighbor or family members. We can also develop an android application where
all the recorded details and the results of all the sensors can be easily seen. Android
applications from the easiest way of human interface. Other Descriptions of the project in
detail are discussed below.

+
DC5V

Accelerometgr
sensor

Temperature sensor

Figure 1. Showing the model of device and components arrangement
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3.1. Movement of fetus

On the way to making an accurate and precise device, the selection of the sensors plays an
important role. To detect the movements of the fetus, we have used an accelerometer sensor.
It can be used to measure acceleration in one, two, and three-axis which is orthogonal.
Kicking, which is the fetus's movement, can be detected by these accelerometers. It will be
present or held in the outside area of the mother's abdominal area. In the uterus, the fetus's
movement is a sign of well being of the baby. It depends greatly on the vascular state of
placental insufficiency [16]. It is observed that there is a fetal movement for prolonged
periods during the third trimester [17]. Information provided to pregnant women about fetal
movements is inconsistent perhaps due to limited knowledge about normal fetal movement
patterns in healthy pregnancies [18].

ADXL335 is the sensor type we have used. This is a small, low power, three-axis
accelerometer module measuring X Y Z values in the form of analog voltages. +3g is the
minimum full-scale range of this sensor. The selection for the bandwidth can vary in the
range of 0.5 Hz to 1600 Hz for Y, X-axis, and 0.5 Hz to 550 Hz for the Z-axis. It has a wide
power range from DC 3V to 5V. It is highly sensitive; hence, we have used it here.

Figure 2. ADXL335

It mainly measures the tilt in the angle to the earth. We too can use vibration sensors but
accelerometer sensors show more precise and accurate values. Fetus movement shows that
there is a growth in the strength and size of the fetus. Less number of movements in a
particular period can be a sign of danger regarding the health of the baby. So keeping in mind
the risk involved, it is very important to maintain a record of the movements. From the
starting of the fourth month [19], the baby starts kicking (the movement of the fetus which is
observed by the mother or by ultrasound technique) usually, but mostly it is not observed by
the mother. The prediction of the development and real condition of the fetus is done by
clinicians by the measurement of fetal movement.

This device can be used instead of the expensive ultrasound technique. The number of kick
counts that can be treated as normal or abnormal is illustrated in the below chart.

Table 1. Fetal movement measurement

Hour Duration no. of kick counts(Normal) no. of kick counts(Abnormal)
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1 hour More than 2 Less than 3
2 hour More than 5 Less than 6
12 hour 11 or greater Less than 11

3.2. Blood pressure measurement

As we know that among all the other parameters, the most important parameter to be taken
care of is blood pressure. Blood pressure variation is harmful to any individual, but for
pregnant women, it can be too risky. We have used a Blood pressure sensor to measure the
blood pressure of the women. Blood pressure measurement and monitoring are quite
necessary for women during the whole period of pregnancy. This could result in dizziness and
can also adversely affect the oxygen and nutrients supply of the baby. If the variation goes on
without treatment, it can be proved deadly. High blood pressure can be the cause of many
serious problems like hypertension [20]. This might also result in many other complications
like preeclampsia. Also, if it continues even after 20 weeks of pregnancy, it can adversely
affect the organs of women like the brain, kidney [21]. So reducing the risk or the danger of
the life of the mother and the baby, we have included this sensor too. Prega care is a complete
kit for health monitoring.

Table 2. Blood pressure measurement for different status of health

Status Systolic mm hg(upper number) Diastolic mm hg (bottom number)
Normal less than 120 less than 80
elevated 120-129 less than 80
High blood pressure . )
(Hypertension stage 1) 130-139 80-89
High blood pressure . .
(Hypertension stage 2) 140 or higher 90 or higher
Hypertensive crisis Higher than 180 higher than 120

3.3. Temperature measurement

The temperature change of the human body is the immune system’s reaction [22]. Fever is
a sign showing that our immune system is fighting and trying to save our body from some
infection. Temperature sensors are used for the measurement of body temperature. Here, we
are using it for the body temperature measurement of the mother. During pregnancy,
temperature variation is quite common. The reason being the increased metabolism, release of
progesterone hormones, due to which the women’s body gives out more heat. Early
pregnancy and high temperature could be a worrying situation. Also, very low temperature is
a sign of serious problems. So to measure the maternal temperature and maintain a proper
record of the fluctuations, fatal conditions can be reduced.MAX30205 is the specific sensor
we are using so that accurate and precise results can be obtained. It has 8 pins and has a
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temperature range of 0-50 degrees Celsius. The voltage range is 2.7-3.3V and low supply
current. It also provides an over-temperature alarm to indicate the danger in case of
temperature rise. Using a high resolution Analog to Digital Converter (ADC), this sensor
converts the temperature measurements to digital form. It has a lockup protected 12C
compatible interface and it is the reason that it can be best suited for medical, wearable fitness
applications.

Table 3. Temperature ranges for different health status conditions

tatus Temperature range(in Celsius) Temperature range (in Fahrenheit)
Hypothermia <350 <C 95 °F
Normal 36.5-37.5 °C 97.7-99.5 F
Fever/Hyperthermia >37.50r383 T 99.5 or 100.9°F
Hyperpyrexia >40 0r 415 104 or 106.7 F

3.4. Heart rate measurement

During pregnancy, there is variation in the heart rate also. [23]. The heart rate of women
declines mostly in pregnancy. Different type of variation is observed at different trimesters of
pregnancy.[24] Here for measuring the heart rate we are using pulse sensors. It’s a quite well
designed, efficient plug-and-play heart rate sensor. Using some jumper cables it can be
connected to Arduino and the sensor clips can be placed onto a fingertip or earlobe for the
measurement purpose. It includes an open source application for monitoring and showing the
results in form of graphs in real-time. The pulse sensor kit contains ear clips, pulse sensors,
velcro dots, velcro straps and connecting cables. It is a highly sensitive and portable sensor
which is used so that heart rate can be easily monitored and risk factor can be reduced.

Other than the above mentioned, we are using ESP8266 Board which will update the
record and will be interfaced with our components. All the information is recorded on the
database on the cloud and then send to the doctor also so that he can take care of the complete
record and give advice as per the condition if required. 10T is used for fulfilling the same
purpose. [25] as is a key playing crucial role in taking care of pregnant women inside and
outside the hospitals. It makes things clear and effective by ensuring that efficient
environment because many small devices which include sensors, RF tags are with the women
and proper monitoring can be easily done from anywhere, anytime. It not only provides a
better environment but also reduces the complications that occur during the pregnancy period.
Hence, we have also used loT.

Table 4. Heart rate for a normal pregnant woman according to age

Age of pregnant woman Normal heartbeat range(beats per minute)

Less than 20 years 140-155
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20-29 135-150
30-39 135-145
40 or older 125-140

4. Android application

Our system uses an android application that helps in accessing the information stored in the
cloud. The application displays the value of the health parameters. This application will be at
three locations: for Wife, Husband & Doctor mobile. The application retrieves Data from one
Real-time Database. The application has been designed using XML and developed using
JAVA language.

A. Features of the application

1. Real-time Body Temperature monitoring.
2. Real-time Body Temperature Status.

3. Real-time Heart-Rate monitoring.

4. Real-time Blood-Pressure monitoring.

5. Total number of Fetal movements.

Figure 3. Prega care application showing the results recorded

B. Development of the application

Requirement analysis: We wanted an android application that could access the sensor
information from the cloud and update it regularly. The application would be present at three
locations: doctor, husband and wife’s mobile phone.

Defining the project scope: These days, as people become more health-conscious than
ever, and lifestyle-related diseases are on the rise, the mobile app can play a significant role in
many aspects. For Example, the health mobile app enables the patients to get access to their
health data anytime and anywhere. That’s why we developed an Android app (PregaCare) for
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pregnancy, Hopeful (Pregnant Women) will have a device connected with her body that can
share the data with the healthcare specialist, husband and also Hopeful.

On the other hand, the healthcare professionals get rid of maintaining and accessing the
printed data as a reference. In a way, the PregaCare app can bring a paradigm shift from print
and laptop-based data to mobile-based data. Also, the healthcare sector is broadly based on
patient-doctor interaction. The mobile app connects them instantly while blurring the
boundaries of countries. Doctors can also communicate securely with other doctors to share
important information.

C. Development

Application has been developed using android studio. Designing is done with XML and
development is done in Java Language.
D. Stabilization

Open Firebase Project-> Go to test Lab> Open Android Project> Generate Apk File>
Browse Apk file in test lab> Processing> Test done> Passed Result.
Hence, our application testing has passed successfully in the Google test lab.

Robo test, Pixel, APl level 26

<

2

Tmin3s a 1

Figure 4. Testing result of Android application on test lab

E. Functional Requirements

Registration Process of SRS (Software Requirements Specification):

e Adding Patients: This app enables the staff at the front desk to include new pregnant
women in the system.

Check Out of SRS:

e Deleting Patient ID: The staff in the administration section of the ward can delete
pregnant women's IDs from the system.

Report Generation of SRS:

e Information of the Patient: PregaCare generates a report on every pregnant woman
regarding various information like pregnant women's name, Phone number, bed number, the
doctor’s name whom it assigns, ward name, and more.

Database of SRS:

e Mandatory Patient Information: Every pregnant woman has some necessary data like
phone number, first and last name, personal health number, postal code, country, address, city,
patient’s ID number, etc.
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e Updating information of pregnant women: PregaCare enables users to update the
information of pregnant women as described in the mandatory information included.

F. Non-functional requirements

There are a lot of software requirements specifications included in the non-functional
requirements of PregaCare, which contains various processes, namely Security, Performance,
Maintainability, and Reliability.

Security:

e pregnant women Identification: The system needs pregnant women to recognize or
themselves using the phone.

e Logon ID: Any users who make use of the system need to hold a Logon ID and
password.

e Modifications: Any modifications like insert, delete, update, etc. for the database can be
synchronized quickly and executed only by the ward administrator.

e Front Desk Staff Rights: The staff at the front desk can view any data in PregaCare, add
pregnant women's records to Application but they don’t have any rights to alter any data in it.

e Administrator rights: The administrator can view as well as alter any information in the
PregaCare.

Performance:

e Response Time: The system provides acknowledgment in just one second once the
¢ pregnant women’s information is checked.

e Capacity: The system needs to support at least 1000 people at once.

e User-Interface: The user interface acknowledges within five seconds.

Maintainability:

e Back-Up: The system offers efficiency for data backup.

e Errors: The system will track every mistake as well as keep a log of it.

Reliability:

e Availability: The system is available all the time.

Retrieve data to
doctor's app

wife
—— Direct alarm system for
emergency

N

—_ 3

Figure 5. Use case diagram showing the interaction of app and device

5. Working and block diagram

In our project, the components i.e. the sensors used for the implementation and their
respective details have been already mentioned. Now further moving on the implementation
so all the data collected from different sensors go to the ESP8266 NODEMCU Wi-Fi module.
Due to the simple IP connections, this Wi-Fi module is chosen. It sends the data to the
database (cloud) where the data is stored. Now as per our use, the result is displayed on the
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android application created by us for the following. We provide the dynamic updates with the
help of two main things i.e. the Firebase and the sensor. The doctor can view the updates by
using the mobile application.

All the basic functionalities are shown with the help of the block diagram below.

Blood
psrgf]?é:e > ESP 8266 — User
NODEMCU | rirebase L -
Wi-fi module > > application
Pulse rate o
sensor v
A A
ADXL335 MAX30205 sensor
(accelerometer (temperature sensor)
Sensor)
Figure 6. Block diagram of “Prega care” sensors interfacing
6. Conclusion

In this paper, we have shown how our idea of the “Prega care” device can be implemented
using different sensors. Keeping in mind the main factors or parameters adversely affecting
maternal and baby health, accurate and precise result giving sensors are used. This device can
be improved further by adding other features as well, but here we have tried to involve most
of the important unavoidable parameters which when taken care of can improve the condition,
especially in rural areas where regular check-up and test is not available or possible. Also, in
cities, it would reduce the crowd in clinics or hospitals as only selected ladies which have
critical conditions or as per the record and doctor’s advice come. Hence, it would surely act as
a helping hand for pregnant women and the baby. It is just a step towards making health
monitoring easier and better than the existing one in some way.
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